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DAY | APRIL (22) MAY (10/25) JUNE (03) JULY (23) | AUGUST (24) SEPTEMBER (20)
M
Tu 1
W 2
[ Qe
Th 1 % > 3
8 o
F 2 (@) ; 4 1
go — —
. : = 1 Culmination: 5 Activities on 2 HOLIDAY
Sat 1 Session begins 8 |_|>j e Summer Vacation 'Rakshabandhan’ (1d-Ul-Zuha)
Sun 2 SUNDAY 4 SUN 2 SUNDAY 6 SUNDAY 3 SUNDAY
7 HOLIDAY
M3 1 - 5 3 (Rakshabandhan) 4
4 HOLIDAY 5 Teachers' Day
Tu (Ram Navami) 2 (|7) 6 4 Van Mahotsav 8 celebrations
Y 5 3 L 7 5 9 Quit India Movement 6
l_ Day
Th 6 4 8 6 10 7
F gayWorld Health 5 (_) 9 7 1 8
Sat 8 2nd Saturday 6 8 10 zZ 8 2nd Saturday 12 2nd Saturday 9 2nd Saturday
9 SUNDAY 7 (QV
Sun (Mahavir Jayanti) SUNDAY E 11 ') 9 SUNDAY 13 SUNDAY 10 SUNDAY —
_ 14 Janmashtami & (V)]
M 10 8 L 12 — 10 Independence Day cele. 1 L
o 11 World 15 HOLIDAY =
Tu 11 9 13 . (Independence Day & 12
<C | Population Day Janmashtami) Q_)
W 12 10 HQLIDAY (Buddha 14 Q 12 16 13 )
Purnima) < O
Th i\?n%(redia}:r{ 11 (i) National Technology Day 15 13 17 14 E
Remembrance Day (i) I/H Chess competition > T
F %é;g'l‘:'r%@() 12 I/H Chess / dance comp. 16 o 14 gelr;';' gﬁzlr)etball Match 15 =
15 (i) World Youth 19 I Basketball Match
Ll | skills Day (ii) asketball Matc
Sat 15 13 2nd Saturday 17 Investiture (Final) 16
2 Ceremony
Sun 16 SUNDAY 14 SUNDAY 18 SUN 16 SUNDAY 20 SUNDAY 17 SUNDAY
M 17 15 19 > 17 21 18
18 World Heritage —
Tu Day - VH Quiz 16 — 20 ) 18 22 19
w |19 17 D> JN e i o |19 23 20
Th 20 18 1 — 22 20 24 21
E 21 19 — >< 23 21 25 Commencement of 22
> o Sanskrit Week Celebration
Sat 2D2a yWorld Earth 20 n - | ignlllpH Yoga 2 23
5] .
Sun 23 SUNDAY 21 SUN © >< 25 SUN 23 SUNDAY 27 SUNDAY 24 SUNDAY
M éimgﬂt%’;yk & | 2 O | | 24 28 25
(- ——
Tu |25 23 ) qc_) 27 2D5ayKa’9" Vietory | 99 26
) 26 Holiday 30 I/H Taekwondo N
w 26 24 g % 28 (Teej) competition 27 <
27 I/H Volleyball - — (7)) 31PTM &
Th | Match (Semi Final) | 22 § Q|2 Z — 28 &
—_— 1 or ature
28 I/H Volleyball © U Conservation Day Z
F Match (Final) 26 > 30 (ii) VM kho-kho 2 %
E comp. (Semi Final) =
b 29 I/H kho-kho )
Sat 29PT™M 27 ] ">_<‘ comp. (Final) 30 <
Sun 30 SUNDAY 28 SUN E LlJ 30 SUNDAY
Mon 29 - 31PTM
Tu 30 5’)
w 31
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DAY | OCTOBER (21) NOVEMBER (23) DECEMBER (23) JANUARY (19) FEBRUAR Y(22) MARCH (15)
M 1
Tu
W 1 HOLIDAY (Haryana ~
Day) <
2 Commencement: 8
'Observance of
Th Vigilance Awareness 4 m |! " !
Week 5 ©
3 HIYUT 9% Aldh - o
F > ) 1 World 5 £ |2 ‘S | 2HOLIDAY (HOLI)
Easir AIDS Day ; E
Sat 4 HOLIDAY (Guru 2 HOLIDAY 6 3 Q| 3 world Wild Life
Nanak Dev's B'Day) (1d-e-Milad) o © Day
Sun 1 SUNDAY £y | 5SUNDAY 3 SUNDAY 7 SUNDAY 4 SUN g 4 SUNDAY
2 HOLIDAY = é = m
M (Gandhi Jayanti) | 29 6 4 wn |8 5 =|°
Tu 3 World Habitat 7 I/H Badminton 5 L 9 6 X 6
Day Match (Semi Final) I— ﬁ
8 I/H Badminton O
W4 Match (Final) 6 9 10 ! !
Th 5 9 7 D 11 8 8 2
. - O
F 6 10 National 8 O 12 National 9 9 O
Education Day == | Youth Day - -
sat |7 11 2nd Saturday 9 2nd Saturday % 132nd Saturday | X | 10 2" Saurday gaig‘r’day <ZE
wn
%] —_
sun | 8SUNDAY 12 SUNDAY 10 SUN Q. | 14 SUNDAY S | 11 SUNDAY | 11SUN S
(Karva Chauth) O
M 9 13 11 15 — | 12 12 §
i ! o
Tu |10 14 Children's Day | 16 — |1 13 w
Celebrations —_ _
11 International day ' | 14 HOLIDAY <
W | of the Girl Child 15 13 17 T | Mahashivratri) | -)
- c =z
12 National Day 16 I/H Gr. Song . - o
Th . ' 18 15 15
for Disaster comp. 14 Science Quiz D <ZE
; [<B)
= 13 World Students 17 15 19 S |16 16
Day o
16 Commencement:
Sat 14 2nd Saturday 18 GANIT Week 20 17 17
Sun 15 SUNDAY 19 SUNDAY 17 SUNDAY 21 SUNDAY 18 SUNDAY 18 SUN
M 16 20 Annual Function 18 22 19 19
Tu 17 21 19 23 20 20
w | 18 Diwali 22 20 24 21 21
Celebrations
19 HOLIDAY 25 Republic Day
Th (Diwali) 23 21 Celebrations 22 22
20 HOLIDAY 2 26 HOLIDAY (Republic
F (Goverdhan Puja) 24 S 22 Day) 23 23
21 HOLIDAY 25 Celebration |9 g
of the © = | 23 (i)'Good Governance
sat (Bhai Dooj) Constitution § Day ' (i) Christmas cele. 27 Farewell to Class XII 24 24
Day <
Sun 22 SUNDAY 26 SUNDAY 24 SUNDAY 28 SUNDAY 25 SUNDAY 25 SUNDAY
25 HOLIDAY
M 23 27 (Christmas) 29 26 26
24 United Nations . 27 National
Tu Day 28 26 30 Martyr's Day Science Day 27
W 25 29 I/H Gr. Dance 27 31 PTM 28 PTM 28 PTM (Result
comp. Declaration)
Th 26 30 PTM 28 29
27 (i) World Day for
Audio-Visual Heritage
F (ii) I/H Football comp. 29 30
(Semi Final)
28 I/H Football
Sat comp. (Final) 30 PTM 31
Sun 29 SUNDAY 31 SUNDAY
M 30
Tu 31PTM




Assessment Structure effective from the Academic Year 2017-18

1. Scholastic Area

Total 100 marks
Subjects 80 marks 20 marks
Student has to score (Internal Assessment)
33% marks out of 80 | Student has to score 33% marks out of overall 20
marks in each marks earmarked in each subject
subject Periodic Test Notebook Subject
(10 marks) Submission Enrichment
(5 marks) Activity (5 marks)
(i) (i) (iii)
Language 1 School will conduct | Periodic This will Speaking &
Examination for 80 | written test cover: Listening Skills
Language 2 marks in each restricted to e Regularity Speaking &
subject covering three in each e Assignment | Listening Skills
Mathematics | 100% syllabus of subject in an Completion | Maths Lab
the subject. Academic e Neatness & | Practical
Science Year. upkeep of Practical Lab
Marks and Grade Average of the Notebook Work
Social Science | both will be best two tests Map Work and
awarded for to be taken for Project Work
individual subjects. | final marks
submission

(i) Periodic Test (10 marks):

The school will conduct three periodic written tests in the entire academic year and the average of the
best two will be taken.

(ii) Notebook Submission (5 marks):

Notebook submission as a part of internal assessment is aimed at enhancing seriousness of students
towards preparing notes for the topics being taught in the classroom as well as assignments. This also

addresses the critical aspect of regularity, punctuality, neatness and notebook upkeep.

(iii) Subject Enrichment Activities (5 marks):

These are subject specific application activities aimed at enrichment of the understanding and skill

development. These activities will be recorded internally by respective subject teachers.



2. Co-Scholastic Activities:

These activities will be graded on a 5-point scale (A to E) and will have no descriptive indicators. No

upscaling of grades will be done.

Activity To be graded on a 5-point scale (A-E) in
school

Work Education By the concerned teacher

Art Education By the concerned teacher

Health and Physical Education (Sports / By the PE Teacher

Martial Arts / Yoga / NCC etc.)

3. Discipline (Attendance, Sincerity, Behaviour, Values):

Discipline significantly impacts career shaping and it helps build character. Sincerity, good behavior
and values develop strength and foster unity and co-operation. Therefore, the element of discipline has
been introduced. Class Teacher will be responsible for grading the students on a 5-point Scale (A to E).

The Internal Assessment comprising 20 marks (10+5+5) entails objectivity and a structured approach.

Grading System: The result of the assessment in all areas would be given in the form of grades.

Scholastic Areas Co-scholastic Areas/Activities
(Grading on 9 point scale) (Grading on 5 point scale)

Grade Marks Range Grade Point Marks Range Grade Point

Al 91 - 100 10.0 A 41-5.0

A2 81-90 9.0 B 3.1-40

Bl 71-80 8.0 C 21-3.0

B2 61-70 7.0 D 11-20

C1l 51 -60 6.0 E 0-1.0

C2 41 -50 5.0

D 33-40 4.0

El 21-32 3.0

E2 00-20 2.0




TEST SCHEDULE
I

Subject Periodic Test 1 | Periodic Test 2 Periodic Test 3 Subject énnugl .
Xamination
Computer Science 01.05.2017 07.09.2017 01.12.2017 Computer Science 05.03.2018
P (Monday) (Thursday) (Friday) P (Monday)

g i;iﬁj g 02.05.2017 08.09.2017 04.12.2017 Vaths 07.03.2018
Reasoning (Tuesday) (Friday) (Monday) (Wednesday)
Maths 03.05.2017 11.09.2017 05.12.2017 Enalish 09.03.2018

(Wednesday) (Monday) (Tuesday) g (Friday)
Enalish 04.05.2017 12.09.2017 06.12.2017 Social Science 12.03.2018
g (Thursday) (Tuesday) (Wednesday) (Monday)
Social Science 05.05.2017 13.09.2017 07.12.2017 Sanskrit 14.03.2018
(Friday) (Wednesday) (Thursday) (Wednesday)
Sanskrit 06.05.2017 14.09.2017 08.12.2017 Hindi 16.03.2018
(Saturday) (Thursday) (Friday) (Friday)
Hindi 08.05.2017 15.09.2017 11.12.2017 ipKtidee & 17.03.2018
(Monday) (Friday) (Monday) Reasoning (Saturday)
Science 09.05.2017 16.09.2017 12.12.2017 Science 19.03.2018
(Tuesday) (Saturday) (Tuesday) (Monday)




Examination Schedule & Syllabus
(Session: 2017-2018)
e ——

Subject PERIODICTEST 1 PERIODIC TEST 2 PERIODICTEST 3 ANNUAL EXAMINATION
80 marks 80 marks 80 marks 80 marks
English 4 May 2017 12 September 2017 6 December 2017 9 March 2018
— Literature — Literature — Literature — Literature
o Poem o Poem o Poem o Poem
= When | Heard = When I Heard the Learn’d = When I Heard the Learn’d = When I Heard the Learn’d
the Learn’d Astronomer Astronomer Astronomer
Astronomer = Where the Mind is Without = Where the Mind is Without = Where the Mind is Without
= Where the Mind Fear Fear Fear
is Without Fear = On the Grasshopper and = On the Grasshopper and = On the Grasshopper and
o Prose Cricket Cricket Cricket
= Lesson 1 = Homeless = Homeless = Homeless
— Grammar = Last Lesson of the = Last Lesson of the Afternoon = Last Lesson of the
o Lessons 1,2, 4,9,15 Afternoon = The Best Wind Afternoon
— Composition o Prose = Going for water = The Best Wind
o Informal Letter = Lessons 1to 6 o Prose = Going for water
o Essay — Grammar = Lessons1to 8 = Skimbleshanks : The
— Comprehension o Lessonslto 5,9, 10, 15,17 |— Grammar Railway Cat
to 21, 24, 25 o Lessonsl1lto 22, 24,25, 29 = If
— Composition o Prose
— Composition o Formal & Informal Letter * Lessons1to 11
o Formal & Informal Letter o Essay — Grammar
o [Essay o Notice o Lessons 1to 25,27 to 31
o Notice o Factual Description — Composition
o Factual Description o Article writing o Formal & Informal Letter
— Comprehension — Comprehension o Essay
o Notice
o Factual Description
o Atrticle writing
o Story writing
o Diary Entry
o Speech
— Comprehension




Examination Schedule & Syllabus
(Session: 2017-2018)
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Examination Schedule & Syllabus
(Session: 2017-2018)

Subject PERIODIC TEST 1 PERIODIC TEST 2 PERIODIC TEST 3 ANNUAL EXAMINATION
80 marks 80 marks 80 marks 80 marks
Tl 8 #S 2017 15 fa#eT 2017 11 REFax 2017 16 ATE 2018
— A R qreHTe | g R areATaT A R aremTan g R areATan
o U 1¥ 3 o TS 1H 9 o WS 1H 15 o 9B 1H 19
— HRd & @ —  oRd T @ R FHr @ref — HRT & @t
o s 1 o U 1H 4 o Us 1H 6 o 9IS 1H 9
—  SHTRIOT —  SgTET STHIOT  SgTET
o 9B 13 o U 1d9 o U 1d 17 o Us 1H§ 20
o 97, fasy o uA, fa§y, wgrEl, o, o uF, A€y, &gl Farg, s o U4, s, wgel, dar,
SN A AT S G, Teolded
Maths 3 May 2017 11 September 2017 5 December 2017 7 March 2018
— Chapters 1 & 2 — Chapters 1t0 8 Chapters 1 to 12 — Chapters 1to 16
Science 9 May 2017 16 September 2017 12 December 2017 19 March 2018
— Chapters1 & 2 — Chapters1t0 9 Chapters 1 to 14 — Chapters 1 to 18
Social 5 May 2017 13 September 2017 7 December 2017 12 March 2018
Science | Our Pasts-IlI — Our Pasts-111 Our Pasts-11 — Our Pasts-11
Chapter 1 Chapters1to 6 Chapters1to 9 Chapters 1 to 12
— Social and Political Life-Ill | — Social and Political Life-II1 Social and Political Life-111 — Social and Political Life-1lI
Chapters 1 & 2 Chapters 1to 5 Chapters 1to 8 Chapters 1 to 10
— Resources and Development | — Resources and Development Resources and Development — Resources and Development
Chapter 1 Chapters 1 to 3 Chapters 1 to 4 Chapters 1 to 6




Examination Schedule & Syllabus
(Session: 2017-2018)
e ——

Subject PERIODIC TEST 1 PERIODIC TEST 2 PERIODIC TEST 3 ANNUAL EXAMINATION
General 2 May 2017 8 September 2017 4 December 2017 17 March 2018
Knowledge | — Living World — Living World — Living World — Living World
— Natural World — Natural World — Natural World
— Structures — Structures — Structures
— Tribes and Culture — Tribes and Culture
— Personalities — Personalities
— Catastrophic Events — Catastrophic Events
— Mixed Bag
— Stars and Ready Reckoners
Aptitude 2 May 2017 8 September 2017 4 December 2017 17 March 2018
and — Qualitative Reasoning — Syllabus covered from April to — Syllabus covered from April to — Complete Syllabus
Reasoning o Sitting Arrangements August November

— Quantitative Reasoning
o Percentage

— Grammar and Usage
o Sentence completion

Computer 1 May 2017 7 September 2017 1 December 2017 5 March 2018
Science — Creating Web Pages in — Creating Web Pages in HTML — Creating Web Pages in HTML — Creating Web Pages in HTML
HTML — More on HTML.: Working with — More on HTML.: Working with — More on HTML: Working with
— More on HTML: Working Text, Table, Links, Forms and Text, Table, Links, Forms and Text, Table, Links, Forms and
with Text, Table, Links, Frames Frames Frames
Forms and Frames — Introduction to MS Access — Introduction to MS Access — MS Access
— Working with Tables in MS Access |— Working with Tables in MS Access | — Introduction to Visual Basic
— Introduction to Visual Basic — Introduction to Visual Basic — Adobe Photoshop
— Adobe Photoshop — Dreamweaver CS3
— Dreamweaver CS3 — Windows installation and
— Windows installation and troubleshooting
troubleshooting — Introduction to windows 8

— Introduction to Java

10



Curriculum Plan of English
(Session: 2017-2018)

- - Subject Enrichment Activity
Mon | Topic Sub Topics | Assessment
— Literature Reader
o Poem » Video
" When I Heard the Learn’d > Free Verse : > Discussion/ Debate
Astronomer » Anaphora, Syllable, Contractions
= Where the Mind is Without Fear | > Figures of Speech: Simile, Metaphor, Alliteration » Grammar Usage
o Prose » Rabindranath Tagore: His famous Poems > N .
. - otebook Assignment
= Chapter 1 A Shot in the Dark » Slang and Colloquialisms, Ellipsis g
— Grammar » Dictation
g_ o The Sentence _ > Kinds of Sentence- Dgclaratlve, Interrogative, > Speaking & Listening
< o Sentence Analysis Exclamatory, Imperative _
» Forming Negative Sentence Skills
» Subject and Predicate ;
» Direct and Indirect Object > R(-eac-ilng Aloud
o Auxiliary Verbs » Primary and Modal Auxiliary verbs (Workbook: Pg 14) > Dictionary — Usage
o Articles » Definite and Indefinite Articles > B h K
o Clauses (Introduction) » Clauses: Main and Subordinate Clause (Workbook: Pg 18) eyond the boo o
— Composition > Informal Letter, Essay » Notebook Submission
— Comprehension o Regularity
PERIODIC TEST 1 o Assignment
— Literature Reader . . completion
o Poem » Meaning of differently - abled
> H .
& = On the Grasshopper and Cricket | > Kinds of Poetry: Sonnet o Neatness & upkeep
= o Prose > Rhyme Scheme of Notebook
—_Chapter 2 » John Keats - his famous poems
The Silver Lining > Figures of Speech —Simile, Alliteration (Workbook- Pg 22)
» Use of Punctuation Marks

11




Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Grammar
o The Present Tense » Simple Tense (Workbook-pg 20) > Video
3 o The Past Tense > Continuous Tense > Discussion/ Debate
> o The Future Tense » Perfect Tense
» Perfect continuous Tense » Grammar Usage
— Composition » Paragraph > Notebook
— Literature Reader _ _ _ Assignment
o Poem » Vikram Seth: a poet with a difference
* Homeless > Orphanage, Old Age Homes, Dormitory, Night Shelters > Dictation
o Frocsﬁapter 5 > Kinds of Prose: Satirical Story > Speaking &

The World — Renowned Nose : E;frgségsz?;; % e\llr\:ghs$(t;?ﬁ:rComposmon Listening Skills
> = Chapter 4 Extreme Weather > Reading Aloud
3 | Grammar -

o Mouals > Use of Modal auxiliary Verbs > Dictionary — Usage
o Adjective Clause > Adjective clause and Adjective Phrase(Workbook: Pg 33, 38) > Beyond the book
» Combining Sentences using Adjective Clause (Workbook Pg35) | » Notebook
o Direct and Indirect Speech » Direct and Indirect Speech : Declarative Sentence, Interrogative Submission
Sentence, Imperative Sentence(Workbook: Pg 27) _
— Composition > Essay, Formal Letter (Workbook: Pg 31) o Regularity
— Literature Reader o Assignment
o Poem » Words to express emotions .
W = Last Lesson of the Afternoon | > Figures of Speech — Alliteration, Metaphor (Workbook: Pg 53) completion
= o ProgE o >  Kinds of Prose — Adventure, Comedy o Neatness &
E: Drggn?irng of the Dawn Wall |~ 'diomatic Expressions, Prefix and Suf_flx upkeep of
= Chapter 6 The Ant- Lion » Use of Hyphens, Comma (Workbook: Pg 48) Notebook

12




Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Grammar
o Participles » Present Participles, Past Participles, Perfect Participles (Workbook: > Video
5 o Adjectives Pg 54) > Discussion/ Debate
3 o The Gerund » Gerund and Infinitive, Gerund Phrase (Workbook: Pg 65)
=) . . . » Grammar Usage
2 o Active and Passive Voice
o Countable and Uncountable | > Meaning and Use of Countable and Uncountable Nouns > Notebook
— Composition > Notice, Factual Description, Essay Assignment
— Comprehension » Dictation
PERIODIC TEST 2 » Speaking &
o — Grammar Listening Skills
g o Determiners » Classification of Determiners > Reading Aloud
@ » Pre determiners, Central Determiners and Post determiners .
o Idioms » ldioms connected with Colours, Numbers > Dictionary - Usage
_ Composition > Article ertlng > Beyond the book
— Literature Reader » Notebook
o Poem _ » Dictionary work: Archaic Usage Submission
* The West Wind > Rhythm, Metre, Rhyme Scheme (Workbook: Pg 67)
o Prose > Figures of Speech : Alliteration o Regularity
—Chapter7 > Suffix and Prefix o Assignment
5 A Boy’s Best friend . . -
]‘é » Kinds of Prose: Science Fiction completion
[&] J—
O Sran;rr\;?]rouns » Kinds of Pronouns: Personal, Possessive, Reflexive o Neatness &
Emphatic, Relative, Interrogative, Indefinite upkeep of
o Linking Verbs » Features of Linking Verbs Notebook
» Co-ordinating and Subordinating Conjunctions (Workbook: Pg 69)

o Conjunctions

13




Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Literature Reader
o Poem > Identifying lambic and Trochaic feet, Rhyme Scheme > Video
I.Drocs;gmg for water > Robert Frost : his unique style of writing > Discussion/ Debate
© > Use of Enjambment
. — Chapter 8 B. Wordsworth » Homonyms, Homophones Suffix and Prefix > Grammar Usage
& |— Grammar > Notebook
= o The Complement » Subject and Object Complement )
3 o Clause (continued) > Kinds of Subordinate Clause: Adverb Clause Assignment
< o Infinitives > To - Infinitives and Bare Infinitives (Workbook: Pg 80) > Dictation
o Relative Clauses » Defining and Non — Defining Relative Clauses > Speaking &
o Prep'o-smons » Kinds of Prepositions: Simple, Compound, Complex Listening Skills
— Composition > Formal Letter Writing, Essay .
— Comprehension > Reading Aloud
PERIODIC TEST 3 » Dictionary — Usage
— Literature Reader > Beyond the book
o Poem » T.S Elliot: Noble Prize winner poet
= Skimbleshanks: The Railway |5 Rudyard Kipling: his famous creations > Notebook
] IC;at > Kinds of Prose: Humorous Fictional Tale Submission
. o Prose » Abbreviations, Synonyms, Acronyms (Workbook: Pg 112) o Regularity
3 = Chapter 9 Diary of ANobody |~ Rhyme, Rhythm o Assignment
é — Grammar .
g o Adverbs and Adverbials » Kinds of Subordinate Clause: Adverb Clause, Noun Clause completion

o Conditionals
o Punctuation

o Direct and Indirect Speech (Contd.)
— Composition

(Workbook: Pg 90, 94, 104)

» Punctuation Marks: Full Stop, Question Mark, Exclamation
Mark, Comma, Semicolon, Apostrophe, Quotation marks,
Hyphen, Dash

» Reported Speech: Imperative Sentence (Workbook: Pg 103)

» Story writing

o Neatness &
upkeep of
Notebook

14




Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Literature Reader » Video
o Poem » Legend: Meaning and example » Discussion/ Debate
= The Inchcape Rock » Spelling: Doubling of Consonants » Grammar Usage
o Pro(s:?] wpter 10 ; I\K/I_aroll< T\:cvgin ?nd Igisl Ifaorlnous books > Notebook
— inds of Poetry: Balla .
A Helpless Situation » Antonyms, Synonyms A§S|gr}ment
— Chapter 11 > Dictation
Twelfth Night (or What You > William Shakespeare : the greatest playwright of all time > Speaking &
Will) » Kinds of Prose: Drama Listening Skills
> » Theme, Plot and Setting and Drama » Reading Aloud
8 |— Grammar _ _ _ _ > Beyond the book
o Active and Passive Voice > Use of Active and Passive > Notebook
o Affixation » Suffix and Prefix Submiss
o Homophones, Homographs, > Meaning and Uses ) I;msalon_t
Homonyms © eg_u anty
o British and American English > Differences in Pronunciation, Spelling and Usage of words ° A55|glnrr_1ent
. ) completion
— Composmon_ » Diary Entry, Speech, Essay o Neatness &
— Comprehension
upkeep of
Notebook
o
g REVISION FOR ANNUAL EXAMINATION
8
LL
% ANNUAL EXAMINATION
b

15
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Curriculum Plan of Mathematics

(Session: 2017-2018)

Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Chapter 1 » Whole numbers
Rational Numbers ; Ilgte_gers > Definitions and
ational numbers
» Roles of zero and one Formulas
» Negative of a rational number > Practice
» Multiplicative inverse
» Properties of rational numbers Assignments
> Representation of rational numbers > Videos
on number line.
— » Rational numbers between two » Maths Lab
E’ rational numbers Practical
— Chapter 2 » Solving equations having variable | > Beyond the book
Linear equations in on one side task
one variable » Application of linear equations
» Equations reducible to Linear form | > Notebook
» Solving equations having variable Submission
on both side
» Reducing equation to simpler form o Regularity
» Reducing equation to linear form .
o Assignment
PERIODIC TEST 1 completion
— Chapter 3 > Polygons o Neatness &
Under§tanding » Convex and concave polygons upkeep of
= Quadrilaterals » Regular and irregular polygon
§ > Angle sum property Notebook
» Sum of measure of exterior angle
of a polygon
» Types of quadrilaterals
» Some special parallelogram
— Chapter 4 » Construction of quadrilaterals
Practical Geometry | > Some special cases of quadrilateral
— Chapter 5 Organising data
Data Handling Group data
% Histogram
) Pie chart

VVVVVYVYVY

Chance and Probability
Equally likely outcomes
Linking chance to probability
Outcomes as events

22




Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Chapter 6 » Squares and square roots
Squares and Square | > Properties of square numbers > Definitions and
Roots » Patterns
» Pythagorean triplet Formulas
» Square root by repeated .
> subtraction > Practice
= » Finding square roots by Assignments
o prime factorization > Videos
o division method
» Square roots of decimal » Maths Lab
» Estimating square root Practical
— Chapter 7 » Cubes » Beyond the book
Cubes and Cube > Patterns task
Roots » Smallest multiple that is a perfect
cube » Notebook
» Cube roots -
Submission
é — Chapter 8 > Increase or decrease percent o Regularity
Z Comparing » Discounts )
Quantities > Profit and Loss o Assignment
» Sales Tax/ VAT completion
» Compound Interest
» Applications of Compound o Neatness &
Interest
upkeep of
Notebook
PERIODIC TEST 2
— Chapter 9 » Monomials, binomials and
. Algebraic polynomials.
8 Expressions and > Like and unlike terms
& Identities » Addition and subtraction of
§- Algebraic Expressions
2 » Multiplication of Algebraic
expressions
» Standard Identities
— Chapter 10 » Views of 3-D shapes
Visualising Solid » Mapping space around us
_ Shape » Faces, Edges and Vertices
) » Euler’s Formula
=
=
O |— Chapter 11 > Area of trapezium
Mensuration > Area of general quadrilateral
» Avrea of special quadrilaterals
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Subject Enrichment Activity

Mon | Topic Sub Topics / Assessment
— Chapter 11 » Area of a polygon
Mensuration » Solid shapes N
» Surface area of cube, cuboid > Definitions and Formulas
and cylinders » Practice Assignments
» Volume of cube, cuboid and > Videos
. cylinder
é » Difference between VVolume | > Maths Lab Practical
% and Capacity > Beyond the book task
< |— Chapter 12 » Concept of exponents > Notebook Submission
Exponents and » Laws of exponents Reaularit
Power » Use of exponents to express © Regularity
small numbers in standard o Assignment
form
completion
PERIODIC TEST 3 o Neatness & upkeep of
: : Notebook
— Chapter 13 » Direct Proporthn
. Direct and Inverse | > Inverse Proportion
2 Proportions
E
& | — Chapter 14 » Factorisation by common
A Factorisation factors _
» Factorisation by regrouping
terms
» Factorisation using identities.
» Division of polynomials
— Chapter 15 > Bar graph
Introduction to ; E‘_etgfaph
Graphs istogram
P » Line graph
- > Linear graphs
g » Applications of graphs
(3}
™ | Chapter 16 > Letters for digits
Numbers
g
= REVISION FOR ANNUAL EXAMINATION
K
S
§ ANNUAL EXAMINATION
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Curriculum Plan of Science
(Session: 2017-2018)

- . Subject Enrichment
Mon | Topic Sub Topics Activity / Assessment
— Chapter 1 » Agricultural practices
Crop » Basic prgctices of crop production > New Terms
Production | » Preparation of soil
and » Sowing _
Management | > Adding manure and fertiliser > Diagrams
» lrrigation
> Protection from weeds > Hands on Activity
= » Harvesting, Storage
o » Food from animals .
< » Videos
— Chapter 2 » Microorganisms
Micro- » Where do microorganisms live? » Practical Lab Work
Organisms » Microorganisms and us
Friend and » Harmful microorganisms
Foe » Food preservation > Research
» Nitrogen fixation
> Nitrogen cycle > Beyond the Book Task
PERIODIC TEST 1 .
» Notebook Submission
— Chapter 3 » What are synthetic fibres?
Synthetic » Types of synthetic fibres :
Fibres and > Characteristics of synthetic fibres o Regularity
Plastics > Plastics .
> » Plastics as materials of choice o Assignment
© . L
S » Plastics and the environment
. . completion
— Chapter 4 » Physical properties of metals and P
Materials: nonmetals
Metals and | > Chemical properties of metals and o Neatness & upkeep
Non-Metal non-metals
0 etals » Uses of metals and nonmetals of Notebook
— Chapter 5 » Coal
Petroleum > Natural gas
» Some natural resources are limited
> . .
S | — Chapter 6 » What is combustion?
” Combustion | » How do we control fire?
and Flame » Types of combustion
> Flame, Structure of a flame
» What is fuel?
» Fuel efficiency
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Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment

Deforestation and its causes
Consequences of deforestation >
Conservation of forest and wild life
Biosphere reserve )
Flora and fauna > Diagrams
Endemic species
Wildlife sanctuary > Hands on Activity
National park

Red data book
Migration
Recycling of paper
Reforestation > Practical Lab Work

— Chapter 7
Conservation
of Plants and
Animals

New Terms

July

> Videos

VVVVVVVYVYVVVYY

Discovery of the cell

The cell

Organisms show variety in cell
number, shape and size » Beyond the Book
Cell structure and function

Parts of the cell

Comparison of plant and animal cells

— Chapter 8
Cell Structure
and Functions

> Research

Task

VVV VYVV

August

Modes of reproduction » Notebook
Sexual reproduction
Asexual reproduction

— Chapter 9
Reproduction
in Animals

Y VYV

Submission

PERIODIC TEST 2 o Regularity

Adolescence and puberty
Changes at puberty o Assignment
Secondary sexual characters

Role of hormones in initiating
reproductive function

Reproductive phase of life in humans
How is the sex of the baby o Neatness &
determined

Hormones other than sex hormones
Role of hormones in completing the
life history of insects and frogs
Reproductive health Notebook

— Chapter 10
Reaching the
age of

Adolescence completion

September

upkeep of

Force-a push or a pull

Forces are due to an interaction
Exploring forces

A force can change the state of
motion

Force can change the shape of an
object

Contact and non- contact forces
Pressure

Pressure exerted by liquids and gases
Atmospheric pressure

— Chapter 11
Force and
Pressure

October

VVVYVY V VVVVY VY VYV VYV VVVY
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Mon

Topic

Sub Topics

Subject Enrichment
Activity / Assessment

October

— Chapter 12
Friction

Force of friction

Factors affecting friction
Friction: a necessary evil
Increasing and reducing friction
Wheels reduce friction

Fluid friction

November

— Chapter 13
Sound

— Chapter 14
Chemical
effects of
electric current

VVV VYV VYV V| VVVVVYYVY

Y VV

Sound is produced by a vibrating
body

Sound produced by humans
Sound needs a medium for
propagation

We hear sound through our ears
Amplitude, time period and
frequency of a vibration
Audible and inaudible sounds
Noise and music

Noise pollution

Do liquids conduct electricity?
Chemical effects of electric current
Electroplating

December

PERIODIC TEST 3

— Chapter 15
Some Natural
Phenomenon

— Chapter 16
Light

VVV VVV

YV VVVVVVVVYVY

Lightning

Charging by rubbing

Types of charges and their interaction,
Transfer of charge

The story of lightning

Lightning safety

Earthquakes

What makes things visible

Laws of reflection

Regular and diffused reflection
Reflected light can be reflected again
Multiple images

Sunlight: white or coloured

What is inside our eyes?

Care of the eyes

Visually challenged persons can read
and write

What is the braille system?

New Terms
Diagrams

Hands on Activity
Videos

Practical Lab Work

Research

V. v vV Y Vv Y VYV

Beyond the Book

Task

> Notebook

Submission

o Regularity

o Assignment
completion

o Neatness &
upkeep of

Notebook
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Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Chapter 17 » The moon > New Terms
Stars And > Thestars > Diagrams
Solar System | » Constellations,
» The solar system » Hands on Activity
» Some other members of the solar > Videos
system
» Practical Lab Work
— Chapter 18 » Air pollution
Pollution of » How does air get polluted? > Research
Air and Water | » Case study- The Taj Mahal > Beyond the Book
> » Greenhouse Effect, What can be
- Task
< done?
= » Water pollution » Notebook
- » How does water get polluted? Submission
» What is potable water and how is
water purified? o Regularity
» What can be done? o Assignment
completion
o Neatness &
upkeep of
Notebook
g
= REVISION FOR ANNUAL EXAMINATION
2
S
= ANNUAL EXAMINATION
=
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Curriculum Plan of Social Science
(Session: 2017-2018)

Subject Enrichment

Month | Topic Sub Topics Activity / Assessment
— Our Pasts-I11 » How important are Dates?
o Chapter 1 » Which dates?
How When & Where » How do we periodise? > New Terms
» What is colonial? » Diagrams
» How do We Know? > Vid
» Administration produces records 10€0S
» Surveys become important » Map Work / Project Work
» What official records do not tell
— Social and Political Life-I1l | » Why Does a Country Need a Constitution? > Research
o Chapter 1 » The Indian Constitution » Notebook Submission
— The Indian Constitution | » Key Features: i
S o Federalism o Regularity
< o Parliamentary Form of Government Separation of Powers o Assignment
o Fundamental Rights completion
o Secularism
o The Fundamental Rights in the Indian Constitution. o Neatness & upkeep of
o Chapter 2 » What is Secularism? Notebook
Understanding » Why is it Important to Separate Religion from the State?
Secularism » What is Indian Secularism?
— Resources and Development | > Types of Resources
o Chapter 1 Resources > Natural Resources, Human Made Resources, Human Resources
» Conserving Resources
» Some Principles of Sustainable Development
>
g PERIODIC TEST 1
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Subject Enrichment

Month | Topic Sub Topics Activity / Assessment
— Our Pasts-I11 » East India Company Comes East.
o Chapter 2 » East India Company begins trade in Bengal
From Trade to Territory » How Trade led to Battles > New Terms
» The Battles of Plassey » Diagrams
» Company officials become “nabobs” .
» Company Rule Expands > Videos
» Tipu Sultan —The “Tiger of Mysore” » Map Work / Project
» War with the Marathas Work
» The Claim to Paramountacy
» The Doctrine of Lapse » Research
> Setting up a New Administration > Notebook
— Social and Political Life-Ill » Why should People Decide? Submission
o Chapter 3 » People and their Representatives .
> Why Do We Need > The Role of the Parliament o Regularity
‘2“ Parliament o to select the National Government o Assignment

— Resources and Development
o Chapter 2 Land, Soil,
Water Natural Vegetation
and Wildlife Resources

o to control, guide and inform the Government Law
Making
Who are the People in Parliament?

A\

Land, Land Use

Conservation of Land Resource

Soil

Factors of Soil Formation

Degradation of Soil and Conservation Measures
Water

Problems of Water Availability

Conservation of Water Resources

Natural Vegetation and Wildlife

Distribution of Natural Vegetation
Conservation of Natural Vegetation and Wildlife

VVVVVVVVVVY

completion
o Neatness &

upkeep of

Notebook
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Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— OQur Pasts-I11 » The Company Becomes the Diwan
o Chapter 3 » Revenue for the Company » New Terms
Ruling The » The need to improve agriculture .
Countryside » The problem > Diagrams
» Anew system is devised > Videos
» The Munro System .
> Al was not well » Map Work / Project
» Crops for Europe Work
> Why_the demand fqr Indian Indigo > Research
> Britain turns to India
» How was Indigo cultivated? » Notebook Submission
» The problem with nij cultivation ;
> Indigo on the land of ryots o Regularity
» The “Blue Rebellion” and After o Assignment
= o Chapter 4 > How did Tribal Groups Live? completion
= Tribal Dikus & o Some were jhum cultivators, Some were hunters and gathers, Some o Neatness & upkeep
The Vision of a herded animals, Some took to settled cultivation of Notebook
Golden Age > How did Colonial Rule Affect Tribal Lives?
» What happened to Tribal Chiefs?
» What happened to the shifting cultivators?
» Forest Laws and their impact
» The problem with trade
» The search for work
» A closer look
» Birsa Munda
— Social and Political
Life-111
o Chapter 4 » Do Laws Apply to All?
Understanding | » How Do New Laws Come About?
Laws » Unpopular and Controversial Laws
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Subject Enrichment

Month | Topic Sub Topics Activity / Assessment
— Resources and » Types of Minerals
Development > Distribution of Minerals > New Terms
o Chapter 3 » Asia, Europe, North America, South America, Africa, Australia, > Diagrams
Minerals and Power Antarctica _
Resources » Distribution in India » Videos
> » Uses of Minerals
S . . » Map Work
= > Conservation of Minerals a? ork/
» Power Resources Project Work
> gg\?v\sntlonal Sources: Firewood, Coal, Petroleum, Natural Gas, Hydel > Research
» Non-conventional Sources of Energy: Solar Energy, Wind Energy, > Notebook
Nuc_:lgar Power, Geothermal Energy, Tidal Energy, Biogas Submission
— Our Pasts-IlI » Policies and the People _
o Chapter 5 » Nawabs lose their power o Regularity
When People Rebel | > The peasants and the sepoys o Assignment
1857 and After » Responses to the reforms _
» Through the Eyes of the People completion
» A Mutiny Becomes a_PopuIar rebellion o Neatness &
» From Meerut to Delhi
> The rebellion spreads upkeep of
§ » The Company Fights Back Notebook
=4 > Aftermath
=)
< o Chapter6 > What Happened to Cities Under Colonial Rule?
Colonization and > How many ‘Delhis’ before New Delhi?
The City > The Making of New Delhi
» Demolishing a past
» Planning a new capital
» Life in the time of partition
> Inside the Old City
» The decline of havelis

>

The municipality begins to plan
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Subject Enrichment

Month | Topic Sub Topics Activity / Assessment
— Social and Political Life-111 » What is the Role of the Judiciary?
o Chapter5 o Dispute Resolution » New Terms
+ Judicia o Judicial Review .
é Y o Upholding the Law and Enforcing Fundamental Rights > Diagrams
S » What is an Independent Judiciary? » Videos
< » What is the Structure of Courts in India? > Map Work /
» What are the different Branches of the Legal System?
» Does Everyone Have Access to the Courts? Project Work
» Research
- PERIODIC TEST 2
3 » Notebook
QE, — Social and Political Life-111 > What is the Role of the Police in Investigating a Crime? Submission
§ o Chapter 6 » What is the Role of the Public Prosecutor? i
n Understanding Our Criminal | > What is the Role of the Judge? o Regularity
Justice System » What is a Fair Trial? o Assignment
— Our Pasts-111 > Indian Textiles and the World Market completion
o Chapter 7 > Words tell us histories
Weavers, Iron Smelters and | » Indian textiles in the European markets o Neatness &
Factory Owners » Who were the weavers? upkeep of
» The decline of Indian Textiles
_ » Cotton mills come up Notebook
o » The sword of Tipu Sultan and Wootz Steel
S > Abandoned furnaces in villages
8 > Iron and steel factories come up in India
— Social and Political Life-111 » Who are Adivasis?
o Chapter 7 » Adivasis and Stereotyping
Understanding > Adivasis and Development
Marginalization » Minorities and Marginalisation
» Muslims and Marginalisation
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Subject Enrichment

Month | Topic Sub Topics Activity / Assessment
— Resources and Development | > Types of Farming >  New Terms
o Chapter 4 o Subsistence Farming _
S Agriculture o Commercial Farming » Diagrams
s » Major Crops » Videos
3] » Agricultural Development
O > Afarmin India > Map Work/
» AFarmin the USA Project Work
— Our Pasts-111 > How the British saw Education > Research
o Chapter 8 » The tradition of Orientalism » Notebook
Civilizing the "Native" | > Grave errors of the East o
Educating The Nation | > Education for commerce Submission
» What Happened to the Local Schools? o Regularity
» The report of William Adam .
> New routines, new rules o Assignment
L » The Agenda for a National Education completion
2 > “English Education has enslaved us”
= > Tagore’s ‘Abode of Peace’ o Neatness &
é o Chapter 9 > Working towards Change pkeep of
Women, Caste and » Changing the lives of widows Notebook
Reform » Girls begin going to school
» Women write about women
» Caste and Social Reform
» Demands for equality and justice
» Gulamgiri
» Who could enter temples?
» The Non-Brahman movement
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Subject Enrichment

Month | Topic Sub Topics Activity / Assessment
— Social and Political Life-111 » Invoking Fundamental Rights
= o Chapter 8 » Laws for the Marginalised » New Terms
o Confronting » Promoting Social Justice > Diagrams
qE, Marginalization » Protecting the Rights of Dalits and Adivasis. _
3 > The Scheduled Caste and the Scheduled Tribes (Prevention of | > Videos
Z Atrocities) Act, 1989
i : » Map Work
» Adivasi Demands and the 1989 Act ap Work /
Project Work
PERIODIC TEST 3 > Research
— Our Pasts-111 New forms of Imperial Art
o Chapter 10 Looking for the picturesque > Notebook
The Changing World of Portraits of authority Submission
Visual Arts Painting history .
What happened to the Court Artists? o Regularity
The New Popular Indian Art o Assignment
The search for a National Art completion
The art of Raja Ravi Verma P
g A different vision of national art o Neatness &
GE) — Social and Political Life-11l The Emergence of Nationalism upkeep of
D o Chapter 11 A nation in the making Notebook
a “Freedom is our birthright” Otehoo

The Making of The
National Movement

VVYVVVVVVVVVVVY VVVVVVVYVYVY

The Growth of Mass Nationalism|

The advent of Mahatma Gandhi

The Rowlatt Satyagraha

Khilafat agitation and the Non-Cooperation Movement
People’s Initiatives

The people’s Mahatma

The happenings of 1922-1929

The March to Dandi

Quit India and Later

Towards independence and Partition
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Subject Enrichment

Month Topic Sub Topics Activity / Assessment
— Social and Political Life-I1l » Water and the People of Chennai
o Chapter 9 > Water as part of the Fundamental Right to Life > New Terms
Public Facilities > Public Facilities .
» The Government’s Role > Dfagrams
> Water Supply to Chennai: Is it Available to All? > Videos
» In Search of Alternatives > Map Work /
— Resources and Development | > Classification of Industries On the basis of: Project Work
o Chapte_r 5 o Raw Materialls » Research
Industries o Size
s o Ownership » Notebook
g > Factors_ affecting Location of Industries Submission
S > Industrial System _
3 > Industrial Regions o Regularity
Q » Distributions of Major Industries o Assignment
» Iron and Steel Industry _
» Jamshedpur completion
> Pittsburgh . o Neatness &
» Cotton Textile Industry
» Ahmedabad upkeep of
» Osaka
. Notebook
» Information Technology (IT)
» Bangalore
» Silicon Valley (California)
— Our Pasts-I11 » Anew and Divided Nation
> o Chapter 12 > A Constitution is Written
S India after Independence | » How were States to be Formed?
= » Planning for Development
m » Five Year Plans
» The Nation, Sixty years On
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Subject Enrichment

Month | Topic Sub Topics Activity / Assessment
— Social and Political Life-Ill
o Chapter 10 » Bhopal Gas Tragedy » New Terms
Law and Social Justice »> What is a Worker’s Worth .
» Enforcement of Safety Laws > D!agrams
» New laws to Protect the Environment > Videos
» Map Work / Project
— Resources and Development
o Chapter 6 > Distribution of Population Work
Human Resources > Density of Population > Research
- » Factors Affecting Distribution of Population
S » Geographical Factors > Notebook
= » Social, Qultural and Economic Factors Submission
i » Population Change _
> Birth Rate, Death Rate, Migration o Regularity
> Patterns of Population Change o Assignment
» Population Composition )
» Population Pyramid completion
o Neatness &
upkeep of
Notebook
5
~ REVISION FOR ANNUAL EXAMINATION
ﬁ
S
~ ANNUAL EXAMINATION
=
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Curriculum Plan of Computer Science

(Session: 2017-2018)

Subject Enrichment

Mon | Topic Sub Topics Activity / Assessment
— Creating Web > HTML » Create a webpage to
Pages in HTML | » Basic HTML tags display list of your
» <BASEFONT > tag, <P> tag friends
» <BR>and <HR> tags, CENTER » Design a webpage
tag displaying paragraph
» Creating Lists on Importance of
HTML
‘T |— Moreon » Inserting Images using <IMG> Tag | » Design a form using
<% HTML.: » Inserting Images as Background, input, text area,
Working with designing Multiple Pages for a checkboxes, radio
Text, Table, website buttons and select tag
Links, Forms » Adding Background to a web page
and Frames » Adding Comments, Designing
Forms
» Designing Frames
» Attributes of the Frame Tag
PERIODIC TEST 1
— Special Effects | » Designing tables » Design a table to make
> in HTML: » Linking the web pages the time-table of your
S creating tables » Adding E-mail Link class
and linking
them with
HTML pages
— Introductionto | » Database and DBMS, Advantages » Make an MS Word
MS Access of a Database, Hierarchy of a document on data
Database types and field
» Starting MS Access, parts of MS properties along with
Access Database important commands
» Interface Window, Components of used to create and
MS Access Database modify tables in MS
» Exiting MS Access Access
> » Access vs. Excel
>
gy - Working with » Creating a Database » Create a table on your
Tables in MS » Creating Tables friends details with 10
Access » Saving a Database records and 5 fields
» Basic Structure of a Table which includes name,
» Opening a Database and Tables address, city, DOB
» Modifying the structure of a Table and email-id
» Inserting and Deleting Records
» Closing a Database and Exiting MS

Access
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. . Subject Enrichment
Mon | Topic Sub Topics Activity / Assessment
— Introduction | » Visual Basic » Design input form for
to Visual » Starting Visual Basic calculating gross salary
Basic » Parts of Visual Basic Window which is the sum of
§ » Properties, Methods and Events Basic Pay, HRA and
= » Creating an Application in Visual DA
< Basic
» Working with Forms and Controls
» Handling Events
PERIODIC TEST 2
g — Introduction | > Adobe Photoshop > Create an Anniversary
£ to Adobe > Applications of Photoshop Card in Photoshop for
r=t Photoshop » Starting Adobe Photoshop your parents
& » Components of Adobe Photoshop » Make a mirror image of
Opening Screen, Making Selection any image
» Tools Palette of Adobe Photoshop
> Creating, opening and Saving an
Image
— More Tools in | » Manipulating Selectors » -Open any image
Adobe » Using canvas of the image retouch it using dodge,
Photoshop » Painting with color, Drawing shapes burn, sponge, blur and
» Changing brightness and contrast sharpen tool separately
» Retouching Tools, Working with » -Select the portion of
Layers the image using lasso
tool and mowe it to
another place
» -Copy a portion of the
image to another file
g — Introduction | » Adobe Dreamweaver » Create a webpage for
) to » Features of Adobe Dreamweaver the timetable of all days
8 Dreamweaver CS3
CS3 » Starting Adobe Dreamweaver CS3
» Adding a web page to the folder
» Dreamweaver CS3 Window
» Adding Text to a Dreamweaver
Document
» Adding Images to a Dreamweaver
Document
» Creating Named Anchor Links,
modifying links, Creating
Hyperlinks
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. . Subject Enrichment
Mon Topic Sub Topics Activity / Assessment
— More on Adobe » Setting Link Colors » Create a collage of
Dreamweaver » Adding Flash Buttons various dishes in MS
» Rollover images, Image maps Paint and link each
» Adding link to word and excel hotspot to the details of
» Documents to an existing the dishes
webpage
E — Windows » Planning an installation > Make a list of common
£ installation and » Performing the installation computer problems you
3 troubleshooting » Troubleshooting encounter while
z » Types of troubleshooting operating a PC
» Steps of troubleshooting
» Common problems and their
troubleshooting
» Windows 8 terminal, touch
gestures
PERIODIC TEST 3
— Introduction to » Features of Windows 8 » Make a presentation on
windows 8 » Windows 8 Editions hardware and software
. » Charms Bar requirements of
3 > Live Apps Windows 7 and
g » Desktop Windows 8
5-‘3 > Working with Windows 8
» Windows 8 keyboard shortcuts
» Comparison between Windows 7
and Windows 8
» Limitations of Windows 8
— Introduction to » Object-Oriented Programming » Develop programs to
Java » Java— An Introduction display some message
» Getting Started with Java, Data on the screen
Types
> » Constants and Variables, Using » Develop a programto
§ Operators calculate sum of 2
= » Classes and Methods in Java numbers
- » Programming examples on
Operators » Develop a programto
» Control Flow Statements find the greater number
» Programming examples on
Control Flow Statements
o
©
g REVISION FOR ANNUAL EXAMINATION
i
%
§ ANNUAL EXAMINATION
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Curriculum Plan of Aptitude & Reasoning
(Session: 2017-2018)

Month Topic Sub Topics
April — Qualitative Reasoning » Sitting Arrangements
— Quantitative Reasoning > Percentage
— Grammar and Usage » Sentence completion
May PERIODIC TEST 1
— Qualitative Reasoning > R_anks _
— Quantitative Reasoning > Time and Distance
— Grammar and Usage > Sentence improvement
July — Qualitative Reasoning » Blood Relationship
— Quantitative Reasoning > Compound interest
— Grammar and Usage > Re-Arrangements ijumbled parts of
sentence
August — Qualitative Reasoning > Family Tree
— Quantitative Reasoning > Average
— Grammar and Usage » Reconstruction of sentences
September PERIODIC TEST 2
October — Qualitative Reasoning > SyIIogi_sr_n
— Quantitative Reasoning > Probability
- Vocabu|ary > Spelllng test
November | — Qualitative Reasoning » Statement anq assumption
— Quantitative Reasoning > Area and perimeter
— Vocabulary » Synonyms
» Antonyms
» One word substitution
December PERIODIC TEST 3
— Qualitative Reasoning > Statement and Conclusion
— Quantitative Reasoning » Volume
» Height and distance
— Vocabulary > Idioms
» Replacing phrases
January — Qualitative Reasoning > Analogy
> Series
— Quantitative Reasoning » Linear equations
» Data Handling
— Passage Completion » Comprehension
» Cloze Test
February REVISION FOR ANNUAL EXAMINATION
March ANNUAL EXAMINATION
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Curriculum Plan of General Knowledge

(Session: 2017-2018)

Month Topic Sub Topics
April — Living World Rafflesia, Chapel Oak Tree, Water Wheel Plant,
Pink-Tipped Anemone, Meerkat, Okapi, Northern
Cardinal, Albatross, Ivory-Billed Woodpecker
May
PERIODIC TEST 1
— Natural World | Vembanded Lake, Angel Waterfall, Nile River,
Southern Ocean
July — Natural World | Mount Kilimanjaro, Amazon Rainforest, Jiuzhaigou
Valley Forest, Kakadu National Park, Gobi Desert,
Mount Bromo, Sistema Cave, Monaco
August — Structures Giant’s Causeway, Sanchi Stupa, Great Wall of
China, Sydney Harbour Bridge, Three Gorges Dam,
Empire Stste Building, Angkor Wat
September
PERIODIC TEST 2
September | — Tribes and Manipuri Dance, Tap Dancing, Pongal, Festival Of
& October Cultures San Fermin, Mundas, Maasai Tribe, Vikings
October — Personalities Henry Ford, Fidel Castro, Amartya Sen, Margaret
Thatcher, Oprah Winfrey, Yuri Gagarin, Raja Ravi
Varma, Michael Jackson
November | — Catastrophic World War-I1, Jammu and Kashmir Flood, 2014
Events
December
PERIODIC TEST 3
— Mixed Bag World Bank, Sports Utility Vehicles, Drones,
Nuclear Energy, Climate Change, National Sports
Awards, Pulitzer Prize, Social Discrimination
January — Stars and Ready | National Parks of India, Books and Authors,
Reckoners Abbreviations and Sobriquets, The Structure of
Government in India, Ranks in the Indian Armed
Forces, Timeline
February REVISION FOR ANNUAL EXAMINATION
March

ANNUAL EXAMINATION
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Curriculum Plan of Moral Education
(Session: 2017-2018)

Month Topic

April — Ubuntu: Being Human

— Peer Pressure

May — Being Loyal to Oneself

July — Fighting the fear of superstitions
— Being Alert

August — Environmental Conservation

— Upasana: An Angel for the Blind

October — Accepting Gifts Gracefully
— Meditation
November — Growing stronger

— Anger Management

December — Saving Planet Earth

January — Yoga and Pranayama
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For Parents...

1 A complete 100% attendance is desirable. Leave of absence can be granted only in case of
serious illness or eventuality or the marriage in blood relation or any emergency, on the
production of a valid document. Parents are advised not to insist on obtaining leave for their
children except when it is absolutely necessary.

2 Parents/Guardians/Students are expected to sincerely adhere to all the existing rules and
regulations of the school which may be modified from time to time. In case of a dispute, the
decision of the Principal shall be final and binding on them.

3 No student is allowed to come to school by bike or car if he/she does not possess a valid driving
license.

4 The school strictly condemns the practice of extra coaching, tuition, professional coaching, etc.

5 Parents are to ensure that their ward takes timely nutritious meals i.e. breakfast, lunch and
dinner containing milk products, seasonal vegetables, fruits, etc. and he/she refrains from fast
food like burger, pizza, noodles, chips, etc.

6 All the students shall converse in English on the School Campus so, parents are to encourage
their ward to speak in English. They must discourage him/her to use abusive language in or
outside the school.

7 Parents are to attend PTMs regularly and check the Student Diary (Almanac) from time to time
for a regulated follow up of their child so that he/she may acquire the habit of working with
utmost regularity.

8 Parents are not to leave their child in the school half an hour before the start of the school and
half an hour after the closure of the school.

9 They are not to send the tiffin of the child through any unknown person. He/ She will not be
allowed to supply the same to the child.

10 Any unknown person will not be allowed to meet the child or fetch him/her from the school.

11 The school fee will be deposited on the quarterly basis by the local cheque only by 10t of April,
July October and January positively. After that late fee fine of Rs. 1/- per day will be charged and
for the dishonored cheque a penalty of Rs. 500- with the late fine will be charged. In case the
cheque is dishonored, the fee along with the penalty and late fine shall be accepted with a
Demand Draft (DD) only.

12 Parents are to ensure that their child comes to school in time in proper school uniform. The late
comers and uniform defaulters will be sent back home from the school entry itself.

13 Please keep the information about address and the telephone numbers updated in the school
records. It helps the school contact you in case of emergency or any other requirement.

GENERAL INFORMATION

The Curriculum Plan is a convenient division of work for an academic year.

It makes learning and teaching fruitful and systematic.

Every student is to undertake learning and writing work according to the prescribed syllabus.

If the stipulated work is not completed by the end of the month, students should approach the
subject-teacher concerned to hold extra classes.

The guardian too should assess the progress of the child in the light of the syllabus covered.

All tests and examinations are held as per the prescribed syllabus.

YV VVY

A\

Parent’s Signature
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